Chapter 548

Tests for Multiple Proportions in a One-Way Design

Introduction

This module calculates the power and sample size for binary data from a one-way design for testing for differences among response proportions of those groups. This is analogous to the classical one-way ANOVA design that is used to analyze means. In the case of only two groups, this procedure produces power and sample size estimates that match those from the two independent-group proportions procedure.

The methods used in this chapter come from Mai and Zhang (2017). They proposed using a likelihood ratio test that has similar power characteristics to logistic regression.

Technical Details

Test Statistic

Technical details are given in Mai and Zhang (2017).

Suppose we have $N_g \ (g = 1, \ldots, G)$ subjects in each of $G$ groups for a total of $N$ subjects. Let $Y_{gj}$ be the binary response (0/1) of subject $j$ in group $g$. The response is modeled by the model $Y_{gj} \sim Bernoulli(P_g)$.

The log-likelihood ratio test statistic

$$\hat D = -2 \sum_{g=1}^{G} N_g \left\{ \bar{y}_g \left[ \ln(\bar{y}) - \ln(\bar{y}_g) \right] + (1 - \bar{y}_g) \left[ \ln(1 - \bar{y}) - \ln(1 - \bar{y}_g) \right] \right\}$$

where $\bar{y}$ is the overall mean of $Y$ and $\bar{y}_g$ is the mean of $Y$ in group $g$.

Under the null hypothesis of equal proportions, this test statistic follows the chi-squared distribution with $G - 1$ degrees of freedom.
**Effect Size**

Cramer’s V is used as a standardized effect size measure. It gives the association between the binary outcome variable and the group variable as a proportion of the maximum possible variation.

The definition of the effect size is

\[
V^2 = -2 \sum_{g=1}^{G} \frac{N_g}{N(G-1)} \left\{ \mu_g \ln(\mu_g) - \ln(\mu_0) \right\} + (1 - \mu_g) \left\{ \ln(1 - \mu_0) - \ln(1 - \mu_g) \right\}
\]

where \( \mu_g = P_g \) is the response proportion for group \( g \), and \( \mu_0 \) is the average response of all groups.

The sample effect size is estimated by

\[
\hat{V} = \sqrt{\frac{D}{N(G-1)}}
\]

**Power**

The power of this test is given by

\[
\text{power} = Pr\{D \geq C|H_1\} = Pr\{\chi^2(df, \delta) \geq C\} = 1 - \Psi_{df,\delta}(C) = 1 - \Psi_{G-1,N(G-1)V^2}[\chi^1_{1-\alpha}(G-1)]
\]

where \( \Psi_{df,\delta} \) is a cumulative distribution function of a noncentral chi-squared random variable with \( df \) degrees of freedom and noncentrality \( \delta \) and \( C \) is the critical value from a central chi-squared distribution with degrees of freedom \( G - 1 \) and significance level \( 1 - \alpha \).

**Sample Size**

The above power formula can be used in a binary search to obtain an appropriate value for the sample size.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

This option specifies the parameter to be solved for. When you choose to solve for *Sample Size*, the program searches for the lowest sample size that meets the alpha and power criterion you have specified. The *Solve For* parameter is displayed on the vertical axis of the plot.
### Power and Alpha

**Power**
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal proportions when in fact the proportions are different.

Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90 (beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

**Alpha**
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal proportions when in fact the proportions are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

### Sample Size and Group Allocation

**G (Number of Groups)**
This is the number of groups (arms) whose proportions are being compared. The number of items used in the Group Allocation boxes is controlled by this number.

**Range**
G ≥ 2.

**Group Allocation Input Type (when Solve For = Power)**
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.

Possible options are:

- **Equal (N1 = N2 = ... = NG)**
  The sample size of every group is \( N_i \). All group sample sizes are equal. Enter one or more values for \( N_i \).

- **Enter group multipliers**
  Enter a list of group multipliers \( r_1, r_2, ..., r_G \) and one or more values of \( N_i \). The individual group sample sizes are found by multiplying the multipliers by \( N_i \). For example, \( N_1 = r_1 \times N_i \).

- **Enter N1, N2, ..., NG**
  Enter a list of group sample sizes, one for each group.

- **Enter columns of Ni’s**
  Select one or more columns of the spreadsheet that each contain a set of group sample sizes going down the column. Each column is analyzed separately.
Ni (Sample Size Per Group)
Enter $Ni$, the number of subjects in each group. The total number of subjects, $N$, is equal to $Ni \times$ (number of groups).

You can specify a single value or a list.

Single Value
Enter a value for the sample size of all groups. If you enter ‘10’ here and there are five groups, then each group will be assigned 10 subjects and the total sample size will be 50.

List of Values
A separate power analysis is calculated for each value of $n$ in the list. All analyses assume that the common, group sample size is $Ni$.

Range of $Ni$
$Ni > 1$

Group Multipliers ($r_1, r_2, \ldots, r_G$)
Enter a set of $G$ multipliers, one for each group.

The individual group sample sizes is computed as $Ni = \text{ceiling}[r_i \times N]$, where $\text{ceiling}[y]$ is the first integer greater than or equal to $y$. For example, the multipliers $\{1, 1, 2, 2.95\}$ and base $Ni$ of 10 would result in the sample sizes $\{10, 10, 20, 30\}$.

Incomplete List
If the number of items in the list is less than $G$, the missing multipliers are set equal to the last entry in the list.

Range
The items in the list must be positive. The resulting sample sizes must be at least 1.

Ni (Base Sample Size Per Group)
Enter $Ni$, the base number of subjects in each group. The number of subjects in the group is found by multiplying this number by the corresponding group multiplier, $\{r_1, r_2, \ldots, r_G\}$, and rounding up to the next integer.

You can specify a single value or a list.

Single Value
Enter a value for the base group sample size.

List of Values
A separate power analysis is calculated for each value of $Ni$ in the list.

Range
$\text{Ceiling}[N \times r_i] \geq 1$.

$N_1, N_2, \ldots, N_G$ (List)
Enter a list of $G$ sample sizes, one for each group.

Incomplete List
If the number of items in the list is less than $G$, the missing sample sizes are set equal to the last entry in the list.

Range
The items in the list must be positive. At least one item in the list must be greater than 1.
Pass Sample Size Software
Tests for Multiple Proportions in a One-Way Design

Columns of Ni's
Enter one or more spreadsheet columns containing vertical lists of group sample sizes.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.

On the spreadsheet, the group sample sizes are entered going down.

Examples (assuming G = 3)

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>C2</td>
<td>C3</td>
</tr>
<tr>
<td>111</td>
<td>1</td>
<td>28</td>
</tr>
<tr>
<td>115</td>
<td>20</td>
<td>68</td>
</tr>
<tr>
<td>100</td>
<td>30</td>
<td>46</td>
</tr>
</tbody>
</table>

Definition of a Single Column
Each column gives one list. Each column results in a new scenario. The columns are not connected, but all should have exactly G rows.

Each entry in the list is the sample size of that group.

Incomplete List
If the number of items in the list is less than G, the missing entries are set equal to the last entry in the list.

Valid Entries
All values should be positive integers. At least one value must be greater than one.

Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.

Group Allocation Input Type (when Solve For = Sample Size)
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.

Options

- **Equal (N1 = N2 = ... = NG)**
  All group sample sizes are equal to Ni. The value of Ni will be found by conducting a search.

- **Enter group allocation pattern**
  Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be rescaled into proportions by dividing each item by the sum of all items. The individual group sample sizes are found by multiplying these proportions by N (the total sample size) and rounding up.

- **Enter columns of allocation patterns**
  Select one or more columns of the spreadsheet that each contain a group allocation pattern going down the column. Each column is analyzed separately.

Group Allocation Pattern (r1, r2, ..., rG)
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be rescaled into proportions of total sample size by dividing each item by the sum of all items. The individual group sample sizes are found by multiplying these proportions by N (the total sample size) and rounding up.

For example, the pattern {1, 3, 4} will be rescaled to {0.125, 0.375, 0.5}. The group sample sizes will be constrained to these proportions (within rounding) during the search for the sample configuration that just meets the power requirement.
Incomplete List
If the number of items in the list is less than $G$, the missing numbers are set equal to the last entry in the list.

Range
The items in the list must be positive. The resulting sample sizes must be at least 1.

Columns of Group Allocation Patterns
Enter one or more spreadsheet columns containing vertical lists of group allocation patterns.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.
Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the group allocation patterns are entered going down.

Examples (assuming $G = 3$)

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
<th>C3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

Definition of a Single Column
Each column gives one allocation pattern. Each column results in a new scenario. The columns are not connected, but all should have exactly $G$ rows.

Incomplete List
If the number of items in a list is less than $G$, the missing numbers are set equal to the last entry in the list before they are rescaled.

Valid Entries
All values should be positive numbers. You can enter decimal values.

Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.

Effect Size - $P_1, P_2, ..., P_G$ (Group Proportions)

Pi's Input Type
Specify how you want to enter $P_1, P_2, ..., P_G$, the response probabilities for each of the $G$ groups.
Options

- **$P_1, P_2, ..., P_G$**
  Specify the values of the response probabilities for each group. The differences among these values represent the effect size that you want to detect.

- **Columns Containing Sets of Pi's**
  Select one or more columns of the spreadsheet that each contain a set of $P_i$'s going down the column. Each column is analyzed separately.
Tests for Multiple Proportions in a One-Way Design

$P_1, P_2, ..., P_G$

Enter the values of the response probabilities, one for each of the $G$ groups. These entries provide values assumed by the alternative hypothesis. The null hypothesis assumes that all of the values are equal. The effect size detected by the study is a function of the differences among these values.

This value is the anticipated mean response probability of all subjects in a particular group.

Range

Each $P_i$ can be any number between 0 and 1. Also, at least one of the values must be different from the rest.

Example

0.2 0.1 0.1 0.1

Incomplete List

If the number of items in a list is less than $G$, the missing numbers are set equal to the last entry.

Columns Containing Sets of $P_i$'s

Enter one or more spreadsheet columns containing vertical lists of $P_1, P_2, ..., P_G$.

Each $P_i$ can be any number between 0 and 1. Also, at least one of the values must be different from the rest.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.

On the spreadsheet, the $P_i$'s are entered going down.

Examples (assuming $G = 3$)

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
<th>C3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>0.1</td>
<td>0.2</td>
<td>0.3</td>
</tr>
<tr>
<td>0.1</td>
<td>0.3</td>
<td>0.4</td>
</tr>
</tbody>
</table>

Definition of a Single Column

Each column gives one set of probabilities. Each column results in a new scenario. The columns are not connected, but all should have exactly $G$ rows.

Incomplete List

If the number of items in a column is less than $G$, the missing numbers are set equal to the last entry in the column.

Valid Entries

Numbers between 0 and 1.

Note

The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.
Example 1 – Determining Power

Researchers are planning a study comparing three heart-rate medications: a standard drug and two experimental drugs. The experimental drugs are expected to have about the same impact on heart rate.

Each subject will receive an application of only one drug. The response that will be analyzed is whether the heart rate is above 60 bpm. With the standard drug, this proportion has been about 0.40. The researchers want a sample size large enough to detect a difference of 0.2 in the response rate. They will use the response proportions of 0.40, 0.20, and 0.20 to represent this difference.

The test will be conducted at the 0.05 significance level. The subjects will be randomly split equally among the three groups.

What powers are achieved by group sample sizes between 20 and 100?

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>3</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (N1 = N2 = ⋯ = NG)</td>
</tr>
<tr>
<td>Ni (Subjects Per Group)</td>
<td>20 40 60 80 100</td>
</tr>
<tr>
<td>Pi's Input Type</td>
<td>P1, P2, ⋯, PG</td>
</tr>
<tr>
<td>P1, P2, ⋯, PG</td>
<td>0.4 0.2 0.2</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Subjects Count</th>
<th>Effect Size</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2867</td>
<td>60 N</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
<tr>
<td>0.5266</td>
<td>120 Ni</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
<tr>
<td>0.7124</td>
<td>180 Pi(1)</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
<tr>
<td>0.8367</td>
<td>240 Pi(1)</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9121</td>
<td>300 Pi(1)</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
</tbody>
</table>

Set(Set Number): Values

P1(1): 0.400, 0.200, 0.200

References

Report Definitions
Power is the probability of rejecting a false null hypothesis.
Total Subject Count N is the total number of subjects in the study.
Subjects Per Group Ni is the number of subjects per group.
Group Proportions Set Pi gives the name and number of the set containing the proportion response for each group.
Effect Size Cramer’s V is a measure of the effect size. It is the association between the outcome variable and the grouping variable. It is the proportion of the maximum variation in the outcome variable accounted for by the grouping variable.
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal means when it is true.

Summary Statements
A sample of 60 subjects, divided among 3 groups, achieves a power of 0.2867. This power assumes a chi-squared test from an analysis with 2 degrees of freedom is used at a significance level of 0.050. The group subject counts are 20, 20, 20. The group proportions under the alternative hypothesis are 0.400, 0.200, 0.200. The effect size is 0.1482.

This report gives the sample size for each value of the other parameters.

This shows the relationship among the design parameters.
Example 2 – Finding the Sample Size

Continuing with Example 1, the researchers want to determine the sample size corresponding to powers of 0.8 and 0.9.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For Sample Size
Power 0.8 0.9
Alpha 0.05
G (Number of Groups) 3
Group Allocation Input Type Equal (N1 = N2 = ... = NG)
Pi's Input Type P1, P2, ..., PG
P1, P2, ..., PG 0.4 0.2 0.2

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>Count</th>
<th>Subjects Per Group</th>
<th>Proportions Set</th>
<th>Effect Size Cramer's V</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8053</td>
<td>222</td>
<td>ri(1) Pi(1)</td>
<td>0.1482</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9001</td>
<td>288</td>
<td>ri(1) Pi(1)</td>
<td>0.1482</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
</tbody>
</table>

Set(Set Number): Values
ri(1): 0.333, 0.333, 0.333
Pi(1): 0.400, 0.200, 0.200

The sample sizes are 222 for a power of 0.8 and 288 for a power of 0.9. Note that the search routine only searches designs that have equal group sizes (i.e. that are divisible by 3 since there are 3 groups).
Example 3 – Comparing Various Effect Sizes

Continuing with Examples 1 and 2, the researchers want to compare the sample size of various sets of group response probabilities. To do this, they will compare the four sets of probabilities shown in the following table. The first row is the response rate for the standard medication. The second and third rows give the anticipated response rates of the experimental medications.

The values in this table must be loaded into the spreadsheet.

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40</td>
<td>0.40</td>
<td>0.40</td>
<td>0.40</td>
</tr>
<tr>
<td>0.10</td>
<td>0.20</td>
<td>0.30</td>
<td>0.30</td>
</tr>
<tr>
<td>0.10</td>
<td>0.20</td>
<td>0.30</td>
<td>0.10</td>
</tr>
</tbody>
</table>

Table of Four Sets of Response Probabilities

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.9</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>3</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (N1 = N2 = ⋯ = NG)</td>
</tr>
<tr>
<td>Pi's Input Type</td>
<td>Columns containing sets of Pi's</td>
</tr>
<tr>
<td>Columns Containing Sets of Pi's</td>
<td>C1-C4</td>
</tr>
</tbody>
</table>

The above table must be entered into the spreadsheet and the column names changed to C1 – C4. Press the Input Spreadsheet icon to the right to view the spreadsheet.

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Subjects Count N</th>
<th>Subjects Per Group N</th>
<th>Group Proportions Set Pi</th>
<th>Effect Size Cramer's V</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9039</td>
<td>108</td>
<td>ri(1)</td>
<td>C1(1)</td>
<td>0.2436</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9001</td>
<td>288</td>
<td>ri(1)</td>
<td>C2(2)</td>
<td>0.1482</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9004</td>
<td>1284</td>
<td>ri(1)</td>
<td>C3(3)</td>
<td>0.0702</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9038</td>
<td>147</td>
<td>ri(1)</td>
<td>C4(4)</td>
<td>0.2088</td>
<td>0.050</td>
</tr>
</tbody>
</table>

Set(Set Number): Values

ri(1): 0.333, 0.333, 0.333  
C1(1): 0.400, 0.100, 0.100  
C2(2): 0.400, 0.200, 0.200  
C3(3): 0.400, 0.300, 0.300  
C4(4): 0.400, 0.300, 0.100
Note that the horizontal axis gives the index of the probability set footnote. Thus, ‘1.0’ is column C1(1), ‘2.0’ is column C2(2), and so on.
Example 4 – Validation of Power Calculation using Mai and Zhang (2017)

Mai and Zhang (2017) page 390 present an example in which $G = 4$, $V = 0.15$, $\alpha = 0.05$, and $N_i = 25$. They obtained a power of 0.572.

Their example did not provide the individual group response rates. Through trial and error, we found the $P_1 = 0.475$, $P_2 = P_3 = P_4 = 0.2$ results in $V = 0.15$, so we will use those values in the validation.

**Setup**

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>$G$ (Number of Groups)</td>
<td>4</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal ($N_1 = N_2 = \cdots = N_G$)</td>
</tr>
<tr>
<td>$N_i$ (Subjects Per Group)</td>
<td>25</td>
</tr>
<tr>
<td>$P_i$'s Input Type</td>
<td>$P_1$, $P_2$, ..., $P_G$</td>
</tr>
<tr>
<td>$P_1$, $P_2$, ..., $P_G$</td>
<td>0.475 0.2 0.2 0.2</td>
</tr>
</tbody>
</table>

**Output**

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Groups: 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Subjects Count</th>
<th>Subjects Per Group</th>
<th>Group Proportions Set</th>
<th>Effect Size</th>
<th>Cramer's V</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5721</td>
<td>100</td>
<td>25</td>
<td>P(1)</td>
<td>0.1500</td>
<td>0.050</td>
<td></td>
</tr>
</tbody>
</table>

Set(Set Number): Values
$P(1): 0.475, 0.200, 0.200, 0.200$

The power of 0.5721 matches the published power exactly, so the procedure is validated.